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• CHAPTER 1 •

AMAZING PHOTO EDITING

We are using Adobe 
Photoshop Elements 6.
Throughout this series, students will learn:

•To Make photos look their best

•To Do more with photos as we learn



About the toolbox

Use tools in the toolbox to select, 
edit, and view images; some tools 
let you paint, draw, and type. The 
toolbox appears on the left side of 
the Full Edit and Quick Fix 

workspaces. In the Full Edit 
workspace, you can move the 
toolbox by dragging the gripper bar 
at the top of the box. You must 
select a tool in the toolbox before 
you can use it. Once selected, the 
tool is highlighted in the toolbox, 

F u l l  E d i t  Wo r k s p a c e

Menu bar Contains 
menus for performing 
tasks. The menus are 
organized by topic. For 
example, the Enhance 
menu contains 
commands for applying 
adjustments to an 
image.

Workspace buttons 
Moves you between the 
Guided Edit, Quick Fix, 
and Full Edit  
workspaces. These 
buttons change 
according to the current 
workspace.

Toolbox Holds tools for 
editing images.

Options bar Provides 
options for the tool you 
select.

Project Bin Displays 
thumbnails of opened 
images, and lets you 
easily manage them.

Palettes Help you 
monitor and modify 
images.

Palette Bin Helps you 
organize the palettes in 
your work area.
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and optional settings for the tool appear in the 
options bar, which is located below the shortcuts 
bar at the top of the workspace. Some tools in 
the toolbox have additional tools beneath them. 
These are called nested tools. A small triangle 
at the lower right of the tool icon signals that 
there are nested tools. When you select a tool, 
any additional nested tools appear in the options 
bar.

Note: You cannot deselect a tool once you select 
a tool, it remains selected until you select a 
different tool. For example, if you’ve selected 
the Lasso tool, and you want to click your image 
without selecting anything, select the Hand tool.

You can view information about any tool in the 
toolbox by positioning the pointer over it. The 
name of the tool appears below the pointer, this 
is called the tool tip. You can click a link in 
some tool tips to see additional information 
about the tool.
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About foreground and background 
colors

You apply the foreground color when you paint 
with the Brush or Pencil tools, and when you fill 
selections with the Paint Bucket tool. The color 
you apply to the Background layer with the 
Eraser tool is called the background color . 
You can see and change the foreground and 
background colors in the two overlapping boxes 

at the bottom of the toolbox. The top box is the 
foreground color, and the bottom box is the 
background color. The foreground and 
background colors are also used together by the 
Gradient tool and some special effects filters.

You can change the foreground or background 
color in the toolbox by using the Eyedropper 
tool, the Color Swatches palette, or the Color 
Picker. About patterns

C o l o r  r e v i e w

1. Choose a color with the 
Eyedropper tool

2. The Eyedropper tool makes 
it easy to copy a color 
without having to select a 
swatch. It copies, or 
samples, the color of an 
area in your photo to set a 
new foreground or 
background color. You can 
sample from the active 
image, from another open 
image, or from your 
computer’s desktop.

3. Click the Lock 
Transparency icon              
at the top of the Layers 
palette to lock the 
transparent areas of the 
layer, so that no painting 
occurs in them. Click the 
icon again to unlock.

4. Note: For type and shape 
layers, transparency is 
locked by default and 
cannot be unlocked 
without first simplifying 
the layer.
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About Patterns

You can paint a pattern with the Pattern stamp tool or fill a 
selection or layer with a pattern that you choose from the 
pattern libraries. Photoshop Elements has several patterns you 
can choose from.

To customize your images, or to make one-of-a-kind scrapbook 
pages, you can create your own patterns. You can save patterns 
that you create in a library, and then load libraries of patterns 
using the Preset Manager or the Pattern pop-up palette, which 
appears in the options bar of the Pattern Stamp tool and the 
Paint Bucket tool. Saving patterns allows you to easily use a 
pattern in multiple images.

Find Edges

The Find Edges filter identifies areas of the image with 
significant transitions and emphasizes edges. Like the Trace 
Contour filter, Find Edges outlines the edges of an image with 
dark lines against a white background and is useful for creating 
a border around an image.

Note: After using filters like Find Edges and Trace Contour 
that highlight edges, you can apply the Invert filter to outline 
the edges of a color image with colored lines or a grayscale 
image with white lines.

Adjustment Layer

A layer that lets you apply color and tonal adjustments to your 
image without permanently changing pixel values. Use 
adjustment layers to experiment with color and color tones. 
You can think of an adjustment layer as a veil through which 
the underlying layers are seen. 

Blending Mode

A feature that controls how pixels in an image are affected by a 
painting or editing tool. The blend color is applied to the base 
(original) color to produce a new color, the result color. When 
applied to layers, a blending mode determines how the pixels 
in a layer blend with pixels in layers beneath it.

More About Blending Modes

Blending modes control how pixels in an image are affected by 
a painting or editing tool. It’s helpful to think in terms of the 
following colors when visualizing a blending mode’s effect:

•The base color is the original color in the image.

•The blend color is the color applied by the painting or editing 
tool.

•The result color is the color resulting from the blend.
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You can choose any of the following blending modes from the 
Mode menu in the options bar:

Normal Edits or paints each pixel to make it the result color. 
This is the default mode. (Normal mode is called Threshold 
when you’re working with an image in bitmap or indexed-color 
mode.)

Dissolve Edits or paints each pixel to make it the result color. 
However, the result color is a random replacement of the pixels 
with the base color or the blend color, depending on the 
opacity at any pixel location. This mode works best with the 
brush tool and a large brush.

Darken Looks at the color information in each channel and 
selects the base or blend color—whichever is darker—as the 
result color. Pixels lighter than the blend color are replaced, 
and pixels darker than the blend color do not change.

Multiply Looks at the color information in each channel and 
multiplies the base color by the blend color. The result color is 
always a darker color. Multiplying any color by black produces 
black. Multiplying any color by white leaves the color 
unchanged. When you’re painting with a color other than black 
or white, successive strokes with a painting tool produce 
progressively darker colors. The effect is similar to drawing on 
the image with multiple felt-tipped pens.

Color Burn Looks at the color information in each channel 
and darkens the base color to reflect the blend color. Blending 
with white produces no change.

Linear Burn Looks at the color information in each channel 
and darkens the base color to reflect the blend color by 
decreasing the brightness. Blending with white produces no 
change.

Lighten Looks at the color information in each channel and 
selects the base or blend color—whichever is lighter—as the 
result color. Pixels darker than the blend color are replaced, 
and pixels lighter than the blend color do not change.

Screen Looks at each channel’s color information and 
multiplies the inverse of the blend and base colors. The result 
color is always a lighter color. Screening with black leaves the 
color unchanged. Screening with white produces white. The 
effect is similar to projecting multiple photographic slides on 
top of each other.

Color Dodge Looks at the color information in each channel 
and brightens the base color to reflect the blend color. 
Blending with black produces no change.

Soft Light Darkens or lightens the colors, depending on the 
blend color. The effect is similar to shining a diffused spotlight 
on the image. If the blend color is lighter than 50% gray, the 

  7  



image is lightened. If the blend color is darker than 50% gray, 
the image is darkened. Painting with pure black or white 
produces a distinctly darker or lighter area but does not result 
in pure black or white.

Hard Light Multiplies or screens the colors, depending on the 
blend color. The effect is similar to shining a harsh spotlight on 
the image. If the blend color is lighter than 50% gray, the 
image is lightened. This is useful for adding highlights to an 
image. If the blend color is darker than 50% gray, the image is 
darkened. This is useful for adding shadows to an image. 
Painting with pure black or white results in pure black or 
white.

Vivid Light Burns or dodges the colors by increasing or 
decreasing the contrast, depending on the blend color. If the 
blend color (light source) is lighter than 50% gray, the image is 
lightened by decreasing the contrast. If the blend color is 
darker than 50% gray, the image is darkened by increasing the 
contrast.

Linear Light Burns or dodges the colors by decreasing or 
increasing the brightness, depending on the blend color. If the 
blend color (light source) is lighter than 50% gray, the image is 
lightened by increasing the brightness. If the blend color is 
darker than 50% gray, the image is darkened by decreasing the 
brightness.

Pin Light Replaces the colors, depending on the underblend 
color. If the blend color (light source) is lighter than 50% gray, 
pixels darker than the blend color are replaced, and pixels 
lighter than the blend color do not change. If the blend color is 
darker than 50% gray, pixels lighter than the blend color are 
replaced, and pixels darker than the blend color do not change. 
This mode is useful for adding special effects to an image.

Hard Mix Reduces colors to white, black, red, green, blue, 
yellow, cyan, and magenta—depending on the base color and 
the blend color.

Difference Looks at the color information in each channel 
and subtracts either the blend color from the base color or the 
base color from the blend color, depending on which has the 
greater brightness value. Blending with white inverts the base 
color values; blending with black produces no change.

Exclusion Creates an effect similar to, but lower in contrast, 
than the Difference mode. Blending with white inverts the base 
color values. Blending with black produces no change.

Hue Creates a result color with the luminance and saturation 
of the base color and the hue of the blend color.

Saturation Creates a result color with the luminance and hue 
of the base color and the saturation of the blend color. Painting 
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with this mode in an area with zero saturation (a neutral gray 
area) causes no change.

Color Creates a result color with the luminance of the base 
color and the hue and saturation of the blend color. This 
preserves the gray levels in the image and is useful for coloring 
monochrome images and for tinting color images.

Linear Dodge (Add) Looks at the color information in each 
channel and brightens the base color to reflect the blend color 
by increasing the brightness. Blending with black produces no 
change.

Lighter Color Compares the total of all channel values for the 
blend and base color and displays the higher value color. Does 
not produce a third color, which can result from the Lighten 
blend, because it chooses the highest channel values from both 
the base and blend color to create the result color.

Overlay Multiplies or screens the colors, depending on the 
base color. Patterns or colors overlay the existing pixels while 
preserving the highlights and shadows of the base color. The 
base color is mixed with the blend color to reflect the lightness 
or darkness of the original color.
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Keys for painting and brushes: Result Shortcut

Switch to Eyedropper tool Any painting tool or shape tool + Option (except Impressionist Brush)

Select background color Eyedropper tool + Option-click

Set opacity, tolerance, or exposure for painting Any painting or editing tool + number keys (for example, 0 = 100%, 
1 = 10%, 4 and 5 in quick succession = 45%).

Cycle through blending modes Shift + + (plus) or - (minus)

Fill selection/layer with foreground or background color Option + Delete (Backspace), or Command + Delete (Backspace)

Display Fill dialog box Shift + Delete (Backspace)

Lock transparent pixels on/off / (forward slash)

Connect points with a straight line (draw a straight line) Any painting tool + Shift-click

Delete brush Option-click brush

Decrease/increase brush size [ or ]

Decrease/increase brush softness/hardness in 25% 
increments Shift + [ or ]

Select previous/next brush size , (comma) or . (period)

Select first/last brush Shift + , (comma) or . (period)

Display precise cross hair for brushes Caps Lock
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Simplify a layer

You simplify a smart object, frame layer, 
type layer, shape layer, solid color layer, 
gradient layer, or pattern fill layer (or a 
layer group imported from Photoshop) by 
converting it into an image layer. You 
need to simplify these layers before you 
can apply filters to them or edit them with 
the painting tools. However, you can no 
longer use the type- and shape-editing 
options on simplified layers.
Select a type layer, shape layer, fill layer, 
or a Photoshop layer group in the Layers 
palette.
Simplify the layer or imported layer 
group:
• If you selected a shape layer, click 

Simplify in the options bar.
• If you selected a type, shape, or fill 

layer, or a Photoshop layer group, 
choose Simplify Layer from either the 
Layer menu or the Layers palette More 
menu.



Apply a filter
Choose the area you want to apply the 
filter to:

To apply a filter to an entire layer, 
deselect any selected areas, and 
then select the layer in the Layers 
palette.

To apply a filter to a portion of a 
layer, use any selection tool to 
select an area.

Choose how to apply the filter:

To use the Filter gallery, choose 
Filter > Filter Gallery, select a 
category, and click the filter you 
want to apply.

To use the Effects palette, choose 
Window > Effects, select a 
category, and double-click the filter 
you want to apply.

To use the Filter menu, choose 
Filter, then choose a submenu 
followed by the filter you want to 
apply. If a filter name is followed 
by ellipses (…), a Filter Options 
dialog box appears.

If a dialog box appears, enter values or 
select options.

If available, select the Preview option to 
preview the filter in the document 
window. Depending on the filter and 
how you are applying it, use one of the 
following methods to preview the filter:

Use the + button or - button under 
the preview window to zoom in or 
zoom out.

Click the zoom bar (where the 
zoom percentage appears) to 
choose a zoom percentage.

Click-drag within the preview 
window to center a specific area of 
the image in the window. 

Click the Show/Hide button  at the 
top of the dialog box to hide the 
filter thumbnails. Hiding the 
thumbnails expands the preview 
area.

Click the eye icon  next to a filter to 
hide the effect in the preview 
image.

If the dialog box contains sliders, hold 
down Option while dragging a slider to 
see a real-time preview (real-time 
rendering).

Click in the image window to center a 
specific area of the image in the preview 

window. (This may not work with all 
preview windows.) Note: A blinking 
line beneath the preview size indicates 
that the preview is being rendered.

If you are using the Filter Gallery, or the 
filter opens in the Filter Gallery, do any 
of the following and click OK:

Click the New Effect Layer button  
at the bottom of the dialog box and 
choose an additional filter to apply. 
You can add multiple effect layers 
to apply multiple filters.

Rearrange applied filters by 
dragging a filter name to another 
position in the list of applied filters 
at the bottom of the dialog box. 
Rearranging the order of filters can 
dramatically change the way your 
image looks.

Remove applied filters by selecting 
the filter and clicking the Delete 
Effect Layer button .

If you are using a Filter command or the 
Effects palette, do one of the following 
and click OK:

Double-click the filter.

Drag the filter onto the image.
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Use the Background Eraser tool

The Background Eraser tool turns color pixels 
to transparent pixels so that you can easily 
remove an object from its background. With 
careful use, you can maintain the edges of the 
foreground object while eliminating 
background fringe pixels.

The tool pointer is a circle with a cross hair 
indicating the tool’s hotspot . As you drag the 
pointer, pixels within the circle and of a 
similar color value as the pixel under the 
hotspot are erased. If the circle overlaps your 
foreground object, and it doesn’t contain 
pixels similar to the hotspot pixel, the 
foreground object won’t be erased.

U s e  T h e  E r a s e r

1. The Eraser tool changes pixels in the 
image as you drag through them. If 
you’re working in the Background 
layer or in a layer with locked 
transparency, erased pixels change 
to the background color; otherwise, 
erased pixels become transparent. 
Transparent pixels are indicated by 
the transparency grid.

2. Select the Eraser tool  from the 
toolbox.

3. Set options in the options bar as 
desired, and then drag through the 
area you want to erase. You can 
specify any of the following Eraser 
tool options:  
Brushes Sets the brush tip. Click the 
arrow next to the brush sample, 
choose a brush category from the 
Brushes pop‑up menu, and then 
select a brush thumbnail.  
Size Sets the size of the brush in 
pixels. Drag the Size pop‑up slider or 
enter a size in the text box.  
Mode Brush mode erases by using 
characteristics of the brush tool, so 
you can make soft-edged erasures. 
Pencil mode makes hard-edge 
erasures like a pencil. Block mode 
uses a hard-edged 16‑pixel square as 
an eraser.  
Opacity Defines the strength of the 
erasure. An opacity of 100% erases 
pixels to complete transparency on a 
layer and to the background color on 
the Background layer. A lower 
opacity erases pixels to partial 
transparency on a layer and paints 
partially with the background color 
on the Background layer. (If Block 
mode is selected in the options bar, 
the Opacity option isn’t available.)
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Use the Magic Eraser tool

The Magic Eraser tool changes all similar pixels when you drag 
within a photo. If you’re working in a layer with locked 
transparency, the pixels change to the background color; 
otherwise, the pixels are erased to transparency. You can 
choose to erase contiguous pixels only, or all similar pixels on 
the current layer.

Use the Magic Extractor

Use the Magic Extractor to make accurate selections based on 
the appearance of foreground and background areas that you 
specify. You can specify these areas by placing colored marks in 
the areas you want to select. After you mark the areas and close 
the dialog box, only the foreground area appears in the photo.

The Magic Extractor makes it easy to select people or objects so 
that you can superimpose them on other backgrounds. For 
example, you can remove yourself from a photo of you on your 
bicycle at home, and superimpose it on a photo of cyclists in 
the Tour de France. You can save the extracted image as a file 
that you can use again and again.

Use the Eraser tool

The Eraser tool changes pixels in the image as you drag 
through them. If you’re working in the Background layer or in 
a layer with locked transparency, erased pixels change to the 
background color; otherwise, erased pixels become 
transparent. Transparent pixels are indicated by the 
transparency grid.

Use the Quick Selection tool

The Quick Selection tool makes a selection based on color and 
texture similarity when you click or click-drag the area you 
want to select. The mark you make doesn’t need to be precise, 
because the Quick Selection tool automatically and intuitively 
creates a border.

Use the Magic Wand tool

The Magic Wand tool selects pixels within a similar color range 
with one click. You specify the color range, or tolerance, for the 
Magic Wand tool’s selection. Use the Magic Wand tool when 
you have an area of similar colors, like a blue sky.

Delete a selected area

If you delete a selection on a Background layer or a layer that 
uses the Lock Transparency option, the selected area is 
replaced with the background color or checkerboard 
background pattern.

 Do any of the following:

 • Choose Edit > Delete to remove the selection. (If you 
delete a selection by mistake, you can choose Edit > Undo to 
get it back.)

 • Press the Backspace or Delete key to remove the 
selection. 

 • Choose Edit > Cut to cut the selection to the 
Clipboard. You can then paste it elsewhere.
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A thaumatrope is a toy that was popular in Victorian times. A disk or card with a picture on each side is attached to 
two pieces of string. When the strings are twirled quickly between the fingers the two pictures appear to combine into 
a single image due to persistence of vision.

The invention of the thaumatrope is usually credited to either John Ayrton Paris or Peter Mark Roget. Paris used one 
to demonstrate persistence of vision to the Royal College of Physicians in London in 1824. He based his invention on 
ideas of the astronomer John Herschel and the geologist William Henry Fitton, and some sources attribute the actual 
invention to Fitton rather than Paris. Others claim that Charles Babbage was the inventor.

Examples of common thaumatrope pictures include a bare tree on one side of the disk, and its leaves on the other, or 
a bird on one side and a cage on the other. They often also included riddles or short poems, with one line on each side.

Information from:

http://en.wikipedia.org/wiki/Thaumatrope

STRING THING

Thaumatrope
the String Thing

http://en.wikipedia.org/wiki/Astronomy
http://en.wikipedia.org/wiki/Astronomy
http://en.wikipedia.org/wiki/Geology
http://en.wikipedia.org/wiki/Geology
http://en.wikipedia.org/wiki/Thaumatrope
http://en.wikipedia.org/wiki/Thaumatrope


Persistence of Vision

Definition: "Persistence of Vision" refers to the 
phenomenon where the retina retains an image for a 
brief split-second after the image was actually seen, and 
lends itself to animation by fostering the illusion of 
motion when we view images in closely-timed sequence 
to one another. We don't notice the fractional skips 
between images because that persistence fills in the 
momentary gap to make the motion seem seamless.

Source:

http://animation.about.com/od/glossaryofterms/g/
pervision_def.htm

The theory of the animated cartoon preceded the 
invention of the cinema by half a century. Early 
experimenters, working to create conversation pieces 
for Victorian parlors or new sensations for the touring 
magic-lantern shows, which were a popular form of 
entertainment, discovered the principle of persistence 
of vision. If drawings of the stages of an action were 
shown in fast succession, the human eye would perceive 
them as a continuous movement. 

Origins

The illusion of motion pictures is based on the optical 
phenomena known as persistence of vision and the phi 

phenomenon. The first of these causes the brain to 
retain images cast upon the retina of the eye for a 
fraction of a second beyond their disappearance from 
the field of sight, while the latter creates apparent 
movement between images when they succeed one 
another rapidly. Together these phenomena permit the 
succession of still frames on a motion-picture film strip 
to represent continuous movement when projected at 
the proper speed (traditionally 16 frames per second).

HUMAN PERCEPTION OF MOTION

A television system involves equipment located at the 
source of production, equipment located in the home of 
the viewer, and equipment used to convey the television 
signal from the producer to the viewer. The purpose of 
all of this equipment, as stated in the introduction to 
this article, is to extend the human senses of vision and 
hearing beyond their natural limits of physical distance. 
A television system must be designed, therefore, to 
embrace the essential capabilities of these senses, 
particularly the sense of vision.

Source:

"persistence of vision." Encyclopædia Britannica. 
Encyclopædia Britannica Online. Encyclopædia 
Britannica Inc., 2012. Web. 04 Apr. 2012. <http://
www.britannica.com/EBchecked/topic/452891/
persistence-of-vision>.
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M a t e r i a l s

1. (Ask if you need the 
following)

2. Two stiff pieces of 
heavy paper or oak 
tag that will fit 
through a digital 
printer (we use 
regular paper and 
glue it together)

3. Two images from 
Magazines, photos, 
digital photos, or 
other sources of 
images could be 
scanned (we use 
appropriate images 
for school)

4. Heavy string or cord 
at least 3 feet long

5. Cellophane tape

6. Rubber cement or 
glue stick

7. Rubber bands
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http://www.clker.com/clipart-fishbowl.html

Clown is freeware
Clown image from:

http://www.visualpharm.com 

http://www.clker.com/clipart-fishbowl.html
http://www.clker.com/clipart-fishbowl.html
http://www.visualpharm.com/
http://www.visualpharm.com/


No t  No r m a l

1. Normally, we start a 
new blank file with 
the dimensions on 
the left, however, we 
need a wider base to 
build our 
Thaumatrope
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Create a new PSE master file. Choose File > 
New. In a new file window set the new file 
size to Width 11 inches, Height 5 inches, 
Resolution 150 Pixels/Inch (a good pixel 
range for printing on a digital printer), RGB 
Mode, and Background White. Save the file. 



F i r s t  S t e p s

1.Go to the View 
Menu and 
turn on Rulers. 
You just need 
to click them 
on.

2.Go to the Tool 
Box and choose 
the 
Rectangular 
Marquee Tool

3.In the Options 
Menu, select 
Fixed Size

4.Set the size to 
5in width by 
5in height
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M a r q u e e

1. Line up the fixed 
size Rectangular 
Marquee so that it 
is .5 inches away 
from the left edge 
and click to set it 
in place. It should 
reach from .5 
inches to 5.5 
inches across the 
top and from 0 to 
5 inches top to 
bottom

2.By setting the left 
edge to .5 we 
hopefully 
eliminate print 
bleeding when 
finish and print.

3. Print bleeding is 
when the printer 
prints past the 
edge of the paper
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S t r o ke

1.Go to the Edit 
Menu and 
select Stroke 
(Outline) 
selection

2.We set the 
Stroke Menu 
with a width of 
2 pixels and a 
dark color. 

3.The location 
should be 
Center and 
Blending Mode 
should be 
Normal with 
Opacity of 
100%
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R e p e a t

1.Repeat the 
Rectangular 
Marquee from 
the 5.5 inches 
location to 10.5 
inches. Repeat 
the Stroke as 
before so you 
have two smaller 
work areas in the 
larger image.

2.By setting the 
work areas, we 
can change 
backgrounds in 
either without 
affecting the 
other, and it is 
easier to fold 
when we finish.
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Placing and sizing the 2 images inside the squares.

Open the image files you have selected or created for 
the two different sides of the spinner. 

From the TOOL BOX select the Move Tool. Drag the 
image into the middle of the first square. If the image 
is too large, resize it by dragging on the corner boxes 
that appear around it with the marching ants.

TIME FOR IMAGES

http://www.clker.com/clipart-fishbowl.html

http://www.clker.com/clipart-fishbowl.html
http://www.clker.com/clipart-fishbowl.html
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Using the Move Tool, 
drag each image onto 

each work area.

Drag a corner to adjust the size so it fills 
as much of the work area as possible
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Fold

We need to flip the 
layers so the fold can 

be in the middle

Your project should 
look similar to ours 
shown here
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Go to the Image Menu and select 
Rotate.
You can choose either Layer 90° 
Left or Right, but both images 
need to face the same direction.

FLIPPING
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Now we need to print. Make sure the printer is 
set to Landscape and your images are not 

bleeding off either edge of the paper



• CHAPTER 5 •

Cut the images and fold the paper.
Tie your string and place as shown.
Glue together. For added strength you may want 
to include a blank piece of paper underneath the 
assembly. Let it dry some before trying.

SOME ASSEMBLY REQUIRED
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To spin:
Hold the ends of the string 
and flip it around till the 
string is completely twisted. 
Pull on the ends of the string 
to spin your illusion and 
create one image from two.

Some Thaumatropes need 
extra spin, so attaching 
rubber bands to the ends of 
the string will aid in spinning 
your project.

So, is it 
persistence 
of vision or 

not?



JUST CHECKING IN
Interactive 

Just Checking.2 Your 
name should appear 

at the top

Learn how to build 
your own widgets 

and publications with 
the complete series

Interactive Just Checking.1 
3D Cube



MONEY SPIN LITE

Interactive Money Spin Lite.1 Trial version of our popular educational activity

Up to 6 players can compete for success in any version of Money Spin

Visit our website at: http://whitebagsoftware.com/

Direct link: http://itunes.apple.com/us/app/money-spin1v4/id437500745?mt=8

Use this 
sample 
puzzle 
review 

interactive 
to learn 
about 
other 

Amazing 
Photo 

Editing 
books. 

Just touch 
to begin.

There are 
many 

puzzles to 
explore 
various 

messages 
including 
our APE 

series and 
our ACT 

series 
along with 
other data

This is a widget 

m
ade from

 an App

http://whitebagsoftware.com
http://whitebagsoftware.com
figure:%23
figure:%23


HELP SUPPORT US
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Our software available in the iTunes Store provides 
the funds needed to produce both free and reduced 
priced Apps and publications.

By buying our products, you will help continue our 
publication of many educational and family fun 
activities.
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Our publications are educational books available on the iBookstore. The ACT series is 
all about advanced features used to create chroma key effects in Apple iMovie utilizing 
application features in Apple Keynote or Microsoft PowerPoint, Apple QuickTime 10, 

and Apple iMovie. They are available for your use..

Interactive 
Help Support Us.1 
The ACT series 
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Our publications are educational books available on the iBookstore. The APE series is all about 
advanced features used to create various image effects available with digital imaging software 

applications. Our educational books are for you to use.

Interactive 
Help Support Us.2 

The APE series
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Modes of Transportation

Foods We Eat

All About Me

All Around the House

Making Change

Our Growing a2z4u&me Series
Interactive 
Help Support Us.3 
Vocabulary help for all
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Interactive 
Help Support Us.4 
An iBuild Opportunity 
series
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